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Preface 

The clearVISN™ Router Configurator is a Graphical User Interface (GUI) 

g 
 

application that enables you to create and load a basic configuration for bridgin
routers running DIGITAL’s Distributed Routing Software. This manual describes
how to:

• Install the clearVISN Router Configurator software, either as part of the 
clearVISN package or standalone.

• Create a configuration for a bridging router.

• Modify a configuration for a bridging router.

• Enter Distributed Routing Software Command Line Interface (CLI) commands 
within the clearVISN Router Configurator, in order to configure features not 
supported by the GUI.

• Load a router from within the clearVISN Router Configurator.

This preface describes how to use this book and the documentation set to which it 
belongs. 

Audience 
This guide is intended for persons who install and operate computer networks. 
Although experience with computer networking hardware and software is helpful, 
you do not need programming experience to use the clearVISN Router Configurator.
ix



 

DIGITAL Documents

The documents in the Distributed Routing Software manual set are listed below.

This Document... Describes...

RouteAbout Access EI Installation 
EK-DEXBR-IN

Installation and use of the RouteAbout Access EI 
router.

RouteAbout Access EW Installation 
EK-DEX2R-IN

Installation and use of the RouteAbout Access EW 
router.

RouteAbout Access TW Installation 
EK-DEWTR-IN

Installation and use of the RouteAbout Access TW 
router.

RouteAbout Central EI Installation
EK-DEZBR-IN

Installation and use of the RouteAbout Central EI 
router.

RouteAbout Central EP Installation
EK-DEZPR-IN

Installation and use of the RouteAbout Central EP 
router.

RouteAbout Central EW Installation
EK-DEZ8R-IN

Installation and use of the RouteAbout Central EW 
router.

Bridging Configuration Guide
AA-QL29E-TE

The configuration and monitoring procedures for 
bridging methods.  Bridging features that enhance 
system performance.

DTF (DIGITAL Trace Facility) User 
Guide
AA-R85DA-TE

How to install and use the DIGITAL Trace Facility, 
which enables you to trace packets within the 
protocol layers of the bridging router.

Event Logging System Messages 
Guide
AA-QL2AE-TE

How events are logged, how to interpret Event 
Logging System (ELS) messages.  Provides a 
description of each ELS message with a 
corresponding corrective action.

Network Interface Operations Guide
AA-QL2BE-TE

Configuring and monitoring the network interfaces in 
the Distributed Routing Software bridging router.
x



Conventions 

The following conventions are used in this manual: 

Monospaced type This special type in examples indicates system output or user input.

Boldface Boldface type in examples indicates user input.

lowercase–italics Lowercase italics in command syntax or examples indicate variables for 
which either the user or the system supplies a value.

This Document... Describes...

Quick Reference Guide
AA-R7QAA-TE

How to configure and monitor the main protocols, 
features and interfaces, and lists the associated 
commands. 

Routing Protocols Reference 
Guide
AA-QL2CE-TE

Reference information about the micro-operating 
system structure, and the protocols and interfaces 
supported by bridging routers. 

Routing Protocols User’s Guide,
AA-QL2CE-TE

Configuring and monitoring the protocols in the 
Distributed Routing Software bridging router.
How to use the Digital Trace Facility.

Systems Network Architecture 
Guide
AA-QU5SC-TE

SNA interfaces and protocols for the Distributed 
Routing Software System.

System Software Guide 
AA-QL2EE-TE

Installing, configuring, and operating the Distributed 
Routing Software system software.
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Introduction

1.1 Overview
 use 
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g 
This chapter describes the clearVISN™ Router Configurator. You can install and
the clearVISN Router Configurator either standalone or as part of the clearVISN
package.

In this manual, the clearVISN Router Configurator is also referred to as the Router 
Configurator.

1.1.1 What Is the clearVISN Router Configurator?

The Router Configurator is a software application that enables you to create, m
and load configuration information for supported bridging routers. 

The Router Configurator has a Graphical User Interface (GUI). You configure 
individual bridging routers by entering information on tab pages for the router 
features that you want.

1.1.2 Supported Routers

You can use the Router Configurator to configure and load the following bridgin
routers:

• RouteAbout Access EW

• RouteAbout Access TW

• RouteAbout Central EW

• RouteAbout Access EI 

• RouteAbout Central EI

• RouteAbout Central EP

• DECswitch 900 EE
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• DECswitch 900 EF.

• DECswitch 900 ET

The supported bridging routers all run Distributed Routing Software, described in 
the Distributed Routing Software documentation set.

In the rest of this manual, supported bridging routers are referred to simply as 
routers.

1.1.3 Router Configurator Environment

The clearVISN Router Configurator runs on a IBM®-compatible personal compu
running Windows NT™ or Windows 95®.

1.2 What Can You Do in the Router Configurator?

The clearVISN Router Configurator enables you to do the following:

• Create one or more configurations for a router

• Modify previously created configurations

• View a summary file containing details of a given configuration

• Configure features not supported in the Router Configurator, using Distributed 
Routing Software CLI commands

• Load the router, using TFTP

1.2.1 Features You Can Configure

The Router Configurator allows you to configure a large number of features and 
parameters for supported routers. You can configure the following:

• General system information, including information  about:

– Management addresses

– Hub membership,

–  SNMP management

– Permitted users

– System time

– BOOTP EasyStart
1–2
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–  BOOTP relay agent

– Boot and dump files.

• Router interfaces and datalinks, including:

– Ethernet

– Token Ring

– FDDI

– PPP

– Proteon Serial Line (PSL)

– V.25bis dial circuits

– ISDN dial circuits

– PPP/frame relay PVCs

– PPP/frame relay SVC dial circuits over serial lines.

– PPP/frame relay SVCdial circuits over ISDN dial circuits

– Frame relay (RFC 1490) PVCs

– Frame relay  (RFC 1490) SVC dial circuits over serial lines.

– Frame relay  (RFC 1490) SVC dial circuits over ISDN dial circuits

• PPP multilink bundles

• WAN restoral

• IP routing, including OSPF, BGP and RIP routing (including triggered RIP).

• IP access controls and filtering.

• DECnet Phase IV routing

• DECnet Phase V/OSI routing

• NetWare IPX routing

• Bridging, including Transparent (spanning tree) and Source Route bridging.

• Bridge protocol filtering

• Telesaving features
1–3
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The Router Configurator lets you configure many, but not all, of the features and 
parameters supported by the Distributed Routing Software 3.0.  In order to configure 
the full set of features, you need to use the router’s CLI commands. The Distrib
Routing Software documentation contains detailed information about the CLI 
commands.

1.2.2 Entering Extra Commands

The Router Configurator has a facility known as the Extra page which allows you to 
use Distributed Routing Software CLI commands to configure features not suppo
by the GUI tab pages. The Extra page allows you to create and test a script of C
commands, save it as part of the router’s permanent configuration, and load it w
the GUI configuration is loaded. Refer to Chapter 4 for details.

1.3 The Router Data File 

The Router Configurator saves router configuration information in the router data 
file. The router data file is the Configurator’s own record of a router’s configurati
kept on the PC. There is a router data file for each router configuration you crea

You can view or change the name of the router data file on the New Router 
Configuration window. You see this window when you first create a new 
configuration for a router.

The information in the data file is used:

• When you open a previously configured router, to show the information that you 
entered

• When you load the router, to indicate the information to be loaded

1.4 The Telesaving Monitor

When you install the Router Configurator, you can also  install the Telesaving 
Monitor. This is a Web-based tool that allows you to monitor Budget usage and 
Budgeting and Scheduling parameters on your router.

You can configure Budgeting and Scheduling in the Router Configurator.  

Refer to Chapter 5 for details.
1–4



Introduction
1.5  Required Steps
1.5 Required Steps

To use the Router Configurator to configure a router, you need to do the following:

1.6 Using Help in the Router Configurator

This manual does not give detailed guidance on using the Router Configurator, or on 
the parameters you need to enter. However, the Router Configurator contains 
extensive online help; see Section 3.8 for more about using online Help.

Step Action Refer to...

1. Install the Router Configurator software. Chapter 2

2. Start the Router Configurator. Chapter 3

3. Configure the router, using the tab pages. Chapter 3 and Chapter 6 

4. If you wish, create a script of CLI commands. Chapter 4

5. Load the router. Chapter 7
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Installing the clearVISN Router

Configurator
This chapter describes how to instal the clearVISN Router Configurator. 
2.1 Introduction

You can instal the Router Configurator in either of two ways:

• From the clearVISN application

• Standalone

This chapter describes both types of installation. 
2–1
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2.2 Preinstallation Information 

Table 2–1 lists the software and hardware required for installation. It applies to both 
standalone and clearVISN installation.

Table 2–1 Installation Requirements 

P C Hardware 
required

Intel®-based 80486 or Pentium® PC with clock speed exceed-
ing 33 Mhz. The PC must also have the following:

• Memory: at least 8 Mbytes on Windows 95
               at least 16 Mbytes on Windows NT

• VGA or better monitor

• LAN network adaptor (Token Ring or Ethernet)

• CD-ROM drive if installing from clearVISN

• Mouse compatible with Microsoft Windows NT or Win-
dows 95

PC Software 
required

• Microsoft Windows NT V3.51 or higher, or Windows 95

• Microsoft TCP/IP network protocol stack (included in 
Windows NT/95)

• Driver installed for network adaptor, or default driver in-
stalled with Windows NT/95

Disk space 
required

During installation: 30 Mbytes
During use:             15 Mbytes

Routers supported • RouteAbout Access EW

• RouteAbout Access TW

• RouteAbout Central EW

• RouteAbout Access EI

• RouteAbout Central EI

• RouteAbout Central EP

• DECswitch 900 EE

• DECswitch 900 EF

• DECswitch 900 ET

Router software 
required

The appropriate Distributed Routing Software (described in the 
Distributed Routing Software manuals).
2–2
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2.3 Installing the Router Configurator from clearVISN

2.3.1 Before You Begin 

Before you install the Router Configurator, close down all  unnecessary applications 
running on your PC. 

2.3.2 Installation Procedure

To install the Router Configurator from clearVISN, follow these steps:

1. Run clearVISN setup, as described in the manual, clearVISN Installation.

2. Click on the Router Configurator line in the clearVISN Component Installation 
window.

3. Complete clearVISN setup. 

If you wish to instal the Telesaving Monitor, refer to Section 2.5. For information 
about the Telesaving Monitor, refer to Chapter 5.

2.4 Installing the Router Configurator Standalone

2.4.1 Before You Begin 

Before you install the Router Configurator, close down all unnecessary applications 
running on your PC. 

2.4.2 Procedure: Installing from the WWW

Follow these steps:

1. Create a temporary installation folder. You can delete the folder once the instal-
lation is complete.

2. Copy the Router Configurator kit to the temporary directory from its World 
Wide Web (WWW) location. You can find this location by going to any of the 
following locations:

Americas:      http://www.networks.digital.com/dr/crc/index.html

Europe:          http://www.networks.europe.digital.com/dr/crc/index.html

Asia Pacific:  http://www.networks.digital.com.au/dr/crc/index.html

Alternatively, you can do the following:

a. Go to one of the following locations
2–3
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http://www.networks.digital.com/
http://www.networks.europe.digital.com
http://www.networks.digital.com.au

b. Click Search, and enter:

clearVISN Router Configurator

3. Once you have copied the Router Configurator to the temporary directory, run 
the following file in the temporary directory:

RTRCONFG.EXE

This will extract the contents of the kit.

4. In the temporary directory, run the installation procedure by double-clicking the 
following file:

SETUP.EXE

If you wish to instal the Telesaving Monitor, refer to Section 2.5. For information 
about the Telesaving Monitor, refer to Chapter 5.

2.5 Installing the Telesaving Monitor

In order to use the Telesaving Monitor, you need to install the Telesaving component 
during the Router Configurator installation procedure.

2.5.1 How to Install the Telesaving Component

The Configurator Setup procedure allows you to install in three different ways:

• Typical installs all Router Configurator components.

• Compact installs the minimum required: the Configurator and BOOTP.

• Custom allows you to select components.

The Telesaving component will be installed if you select Typical, or if you select 
Custom and choose Telesaving as one of the components. 
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2.5.2 Install Web Server

If you specify Typical or Custom with the Telesaving component, you are asked if 
you wish to install a Web server:

• If you already have a Web server installed, leave this box unchecked.  You will 
see the dialog in Section 2.5.3.  Note that a number of Web servers are available 
free from the World Wide Web.

• If you have no Web server installed, then check the box. You will see the dialog 
in Section 2.5.4. The setup procedure will install the Web server supplied with 
the Router Configurator.
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2.5.3 Web Server Already Installed

If you check the Install Web Server box, you see a dialog similar to the following 
example. Each field is explained below.

2.5.3.1 Install to 

 This is the main directory of your Web server. You may need to consult the 
documentation for your Web server to find out where this is located.

You can choose to install to a subdirectory of the Web server directory. For example, 
if your Web server directory is C:\inetpub\wwwroot, you can choose to install to 
C:\inetpub\wwwroot\Telesaving. 

Note that if you install to a subdirectory of the Web server directory, you will need to 
make changes to the Web field, as described in Section 2.5.3.3.
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2.5.3.2 Install scripts to 

This is the scripts directory of your Web server, where the Telesaving CGI script is 
located. Typically, most Web servers separate the scripts directory from the Web 
directory for security reasons. Again, you will need to consult the documentation of 
Web server to find out where this is located.

2.5.3.3 Web 

This is the URL to access your Web site. Typically it is just the fully qualified 
domain name of your PC. However, if you choose to install  the Web server in a 
subdirectory of the Web server directory, then this URL must show the subdirectory. 

For example, if your Web server directory is C:\inetpub\wwwroot, and you choose 
to install to C:\inetpub\wwwroot\Telesaving, you also need to add /Telesaving to 
the end of the Web field.

 For example, if the URL to access your Web site is: 

http://fred.webfield.com 

then the Web field should be:

http://fred.webfield.com/Telesaving 

2.5.3.4 Scripts

This is the Web reference to the location of the scripts directory. It is added at run 
time to the Web field. For example, if the Web field is:

http://fred.webfield.com 

then the scripts field should be:

http://fred.webfield.com/scripts

If you want to use a directory other than the default scripts directory, you will need to 
consult your Web server documentation to find out how to make the directory script-
executable.  

2.5.3.5 SNMP Port 

This is the TCP/IP services port number used for the Telesaving Java applet to 
communicate with the SNMP server. Usually the value 5701 is free, but you may 
need to consult your services file to make sure. 
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2.5.4 No Web Server Installed

If you check the Install Web Server box, the setup procedure will install a Web 
server for you. 

Note that if you want to use this Web server, you must do one of the following:

• Start it up manually. You will need to restart it each time you login

• Put it in the Startup group.

 If you choose to install the Web server, most of the directories are set to be the 
Router Configurator installation directory, and fewer questions are asked. You need 
only supply the Web URL and the SNMP port number, as all the other directories are 
known.  Note that if you specified a subdirectory for the Router Configurator 
installation directory, this needs to be reflected in the Web URL (as explained in 
Section 2.5.3.3). 

2.6 Post-installation (clearVISN and Standalone)

Once you have installed the Router Configurator, you can start it, and use it to 
configure supported routers.However, in order to able to load a configuration to a 
router, manage it over the network, or configure it using CLI commands, you must 
meet the requirements listed in Section 2.6.1.

2.6.1 Setting Up the Router

Before you attempt to load the router, the following requirements must be met:

• The router must be be loaded with the appropriate Distributed Routing Software.

• The router and the PC must be connected to the same IP network.

• The router must have an IP address. If the router is new, or its configuration 
information has been cleared, it will not have an IP address. 

There are two methods for giving a router an IP address, depending on the 
Distributed Routing Software (DRS) version:

– For Version 1.1 or earlier, you must use the console setup port to enter a
band IP address and, if necessary, a gateway IP address. You also nee
supply the same in-band IP address and gateway IP address (if used) w
the Router Configurator; see Section 3.5.
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– For Version 2.0 or later, the EasyStart facility enables the router to act as a 
BOOTP client, and obtain its IP address from a local BOOTP server or 
another BOOTP server on the network. Refer to Chapter 6 for more info
tion.

Note also that these requirements only apply to sending CLI commands to the r
or loading it. You can install the Router Configurator and use it to create a 
configuration without being connected to the router.

2.6.2 Using the Setup Port (Version 1.1 or Earlier)

If you are running DRS Version 1.1 or earlier, you need to use a console termin
connected to the router’s setup port to provide basic configuration information f
DECswitch or Routeabout routers. This information includes the in-band IP add
and the gateway IP address.

• DECswitch and Routeabout Central routers do not have their own setup port; 
instead, they use the setup port on the DEChub™ in which they are installe

• RouteAbout Access routers have their own setup port. 

For detailed information about using the setup port, refer to the DECswitch and 
RouteAbout Installation manuals. 

Procedure: Routeabout Access Routers

This section summarizes the steps needed to use the setup port to configure an in-
band IP address and gateway IP address on RouteAbout Access routers.

1. Install the router, either standalone, or in a DEChub 90 or a DEChub 900 Multi-
switch hub. 

2. Connect a PC or terminal to the setup port, as described in the router’s Installa-
tion manual. Note that if you are installing the router in a DEChub 900, you m
want to redirect the DEChub 900 setup port to the RouteAbout Access setu
port.

3. Select the IP configuration option from the Installation menu.

4. Enter the router’s in-band IP address. 

5. If the PC from which you load and/or manage the router is on a different su
from the router, enter a default gateway address. This is the address of ano
router that the router can use to communicate with the PC.

6. Restart the router.
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Procedure: DECswitch and Routeabout Central Routers

This section summarizes the steps needed to configure an in-band IP address and 
gateway IP address on RouteAbout Central and DECswitch routers.

1. Install the DECswitch or RouteAbout Central router in a DEChub ONE-MX or a 
DEChub 900 Multiswitch hub. 

2. Connect a PC or terminal to the DEChub setup port, as described in the Installa-
tion manual. Note that if you are installing the router in a DEChub 900, you need 
to redirect the DEChub 900 setup port to the router’s setup port.

3. Select the IP configuration option from the Installation menu.

4. Enter the router’s in-band IP address.

5. If the PC from which you load and/or manage the router is on a different su
from the router, enter a default gateway address. This is the address of ano
router that the router can use to communicate with the PC.

6. Restart the router.

2.6.3 Using EasyStart BOOTP (DRS Version 2.0 or Later)

Refer to Chapter 6.

2.6.4 Using the Telesaving Monitor (DRS Version 3.0 or Later)

Refer to Chapter 5.

2.7 Updating a Router Configuration

When you load a new version of  Distributed Routing Software to the router, you
also update the configurations you have created in the Router Configurator to b
compatible with the new version. Note that this is not required.

2.7.1 Procedure

Follow these steps:

1. Start the Router Configurator, as described in Chapter 3.

2. Select a configuration in the Browser.

3. On the Router menu, select Modify, and then select Router Software.

4. A window will appear, on which you can change the version number of the s
ware. You can also change the type of license, if you wish.
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Starting and Using the Router Configurator

3.1 Introduction
This chapter describes how to start and use the clearVISN Router Configurator. For 
detailed information about the information you enter, refer to the Router Configura-
tor’s online help.

3.1.1 Starting the Router Configurator 

You can start the Router Configurator either from the clearVISN network manage-
ment program, or as a standalone program. 

3.2 Starting the Router Configurator from clearVISN

There are two ways to start the Router Configurator from clearVISN:

• From the clearVISN pull-down File menu

• From a clearVISN Device icon popup menu

3.2.1 Starting from the File Menu

On the clearVISN main window, select the option Router Configurator on the pull 
down File menu. The Main Router Configurator window will appear.

3.2.2 Starting from a Device Popup Icon Menu

3.2.2.1 Before You Begin

Before you can start from a Device icon popup menu, you must create a clearVISN 
device for at least one router. Refer to Section 3.2.3  for details.
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3.2.2.2 Procedure

Follow these steps:

3.2.3 The Router Configurator and clearVISN Devices

In order to use clearVISN to manage a network device (such as a router), you need to 
create a device icon to represent the device. 

The Router Configurator does not automatically create router device icons. You need 
to create router device icons as described in Section 3.2.4.

Step Action Result

1. On the File menu, select Show 
Devices. 

The Device window appears, with icons for 
network devices.

2. If there is no icon for a router 
device, create one; see Section 
3.2.4. 

The new device will appear in the Device icon 
window.

3. Select the router device while hold-
ing down the right mouse button.

The Device popup menu appears.

4. On the popup menu, select Router 
Configurator.

The Router Configurator Main window 
appears. You can now create a new configu-
ration or modify an existing one.
Note:  You can create a new configuration for 
any supported router, not just the one whose 
device you selected.
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3.2.4 Creating a clearVISN Device for a Router

To create a clearVISN device for a supported router, follow these steps:

3.3 Starting the Router Configurator Standalone

3.3.1 Windows 95-style User Interface

From the Start menu, choose 

Programs Ð Digital Configurators Ð clearVISN Router Configurator

3.3.2 Windows 3.1-style User Interface

1. Double click the icon Digital Configurators.

2. Double click the icon clearVISN Router Configurator.

Step Action Result

1. On the File menu, select New 
Devices. 

You are asked for the IP address and an 
SNMP community name for the router.

2. Type in the router’s in-band IP 
address and a community name, and 
click OK (refer to Chapter 2 for more 
about the in-band IP address).

clearVISN will try to reach the router over 
the network, using SNMP.
If the router is available over the network, 
clearVISN will create a device icon for the 
router. 
If the router is not available, no icon will be 
created. Go to Step 4.

3. To see the device icon, select Show 
Devices from the File menu.

The Device window appears, with the 
device icons.

4. When the router has been connected 
to the network, select Discover 
Devices from the Tools menu.

clearVISN will create a device icon for the 
router. 
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3.4 Using the Router Configurator

3.4.1 Introduction

When you start the Router Configurator, it displays the Router Configurator main 
Window. This window contains a menu bar and the Browser.

If you are starting the Router Configurator for the first time, it also displays the New 
Router Configuration window; see the example in Figure 3–3.

Figure 3–1 Example Router Configurator Main Window

3.4.2 The Browser 

The Browser contains a list of previously created router configurations. When you 
start the Router Configurator for the first time, the Browser only contains column 
headings.
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By default, the Browser shows the following information for each configuration:

• The name of the router for which the configuration was created

• The name of the configuration. A single router can have multiple configurations

• Whether the configuration is currently loaded

• The hardware type of the router - for example, RouteAbout Access EW.

You can select additional display options from the Browser menu on the menu bar.

Note that if the clearVISN DECNIS Configurator is also installed, the Browser list 
includes any DECNIS configuration created by that Configurator.

3.4.3 The Menu Bar

The menu bar varies slightly depending on what you are doing in the Router Config-
urator. If you have not yet opened a router configuration, the menus are as follows:

• Router menu. Lets you create new configurations, modify existing router con-
figurations or software versions and license types, delete configurations, rename 
a router or configuration, produce multiple identical configurations for a router, 
specify whether or not BOOTP should be used,  or exit from the Router Config-
urator.

• Browser menu. Lets you display additional information in the Browser window 
- for example, the date when the configuration was created, the router’s har
ware address and/or IP address, the version of Distributed Routing Software
ning on the router, or the type of software license.

• View menu.  Lets you display or hide the Router Configurator toolbar, the stand-
ard toolbar and/or the status bar.

• Window menu. Lets you arrange icons or views of the Main Navigation win-
dow.

• Help. Takes you to the Help menu.
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3.4.4 The Main Navigation Window

When you create or modify a configuration, the Main Navigation window appears. 
This window enables you to do the following:

• Go to the tab pages for the features you want to configure

• Go to the Extra page for the router

• Load the router

• View or print a summary of a router’s configuration

Figure 3–2 Example Main Navigation Window
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3.4.4.1 Using the Main Navigation Window

The Main Navigation window has the following features:

• Feature buttons. These are: System, Interfaces, Bridging, IP Routing, IPX and 
DNA IV/V + OSI. When you click a features button, you go to the tab pages for 
that feature.

• Wanted column. Initially, the boxes in the Wanted column show N, to mean not 
wanted. If you want to configure a feature, you must first click the box next to it 
so that it shows a Y. 

• Done column. When you have provided all the mandatory information for a fea-
ture on its tab pages, a box with a green check appears next to the feature in the 
Done column. 

• The Extra button takes you to the Extra page, where you can create an Extra 
script of CLI commands.

• The Summary button displays a printable text file with a summary of the router 
configuration. You cannot display or print a summary until you have completed 
a valid configuration for the router. 

• Clicking the Load button loads the router with your configuration. This button is 
greyed out until you have completed a valid configuration; that is, until you have 
provided all the mandatory information for the features you want.
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3.5 Creating a Router Configuration

The general method for creating a configuration is as follows:

 
Step Action Result

1 Start the Router Configurator. The main Window appears

2 Select New from the Router menu The New Router Configuration win-
dow appears; see Figure 3–3

3 Enter a router name and configuration 
name, and select the other information 
from the menus. Click OK.

The Main Navigation window appears

4 On the Main Navigation window, click the 
System button.

You go to the General tab page within 
the group of System tab pages. 

5 Complete the options on the General tab 
page. The hardware address and in-band 
IP address are mandatory. If you wish, 
configure any of the other System tab 
pages. Click OK.

If you have configured the mandatory 
information, and there are no syntax 
errors, the information is saved, the tab 
pages are closed, and you go back to 
the Main Navigation window.

6 In the Wanted column, click the boxes 
next to the features you want. 

When you click a box in the Wanted col-
umn, the features button next to it 
becomes operational.

7 Click a features button. You go to the feature’s tab pages.

8 Enter the required information on the tab 
pages and click OK.

The result is the same as for Step 5.

9 Repeat Steps 7 and 8 until you have con-
figured all the features you want.

The Done boxes for the features all 
have a green check, and the Load but-
ton is operational.

10 If you wish to create an Extra script of CLI 
commands, click the Extra button. 

You go to the Extra page. 

11 When you have finished creating an 
Extra script, click Close.

You go back to the Main Navigation win-
dow.

12 Click the Load button . The Router Configurator attempts to 
load the router.
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Figure 3–3 Example New Router Configuration Window

3.6 Entering Extra Commands

When you click the Extra button on the Main Navigation window, the Extra page is 
displayed. Refer to Chapter 4  for more information. 

3.7 Loading the Router

When you click the  Load button on the Main Navigation window, the Router Con-
figurator attempts to load the router. Refer to Chapter 7  for more information.
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3.8 Online Help in the Router Configurator

The Router Configurator provides online help in standard Windows® format. Yo
can find Help in either of in two ways:

• Click the Help button on a tab page.

• Select Contents on the Help menu on the Router Configurator menu bar. 

To find out more about using Windows help, select Using Help on the Help menu.
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Entering Extra Commands

4.1 Introduction
xtra
The Extra page in the clearVISN Router Configurator enables you to configure fea-
tures that are supported by the router’s Command Line Interface (CLI), but not sup-
ported by the Router Configurator’s Graphical User Interface (GUI). From the E 
page, you can do the following:

• Create an Extra script of CLI commands, and save it in the router data file. 

• Save prebuilt Extra script files as part of the router configuration file. Example 
Extra script files are supplied with the Router Configurator kit.

• Test individual CLI commands interactively by Telneting them to the router.

• Test an entire Extra script by Telneting it to the router.

• Save CLI commands in a text file.

• Specify a surrogate router to use for testing CLI commands.

4.1.1 What Is an Extra Script?

An Extra script contains two kinds of information:

• CLI commands. These are the mechanism used by the Distributing Routing 
Software to configure the router.

• Keyword directives inserted between the CLI commands. These provide syn-
chronization, timing and error checking facilities needed to make a succession of 
CLI commands run as if they were being entered interactively.

4.1.2  Why Keyword Directives Are Needed

Keyword directives are needed because of the way the Router Configurator sends 
CLI commands to the router.
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The Router Configurator sends CLI commands to the router by running the Distrib-
uted Routing Software utility CONFIG within a Telnet session. The CONFIG utility 
assumes that you are entering commands interactively – that is, entering a com
waiting for a prompt, entering another command, and so on. If the Router Config
tor is Telneting an Extra script – that is, a succession of saved CLI commands -
must provide a substitute for the human action of waiting for prompts or respon
to messages. It does this by inserting keyword directives. 

For more about keyword directives, read Section 4.3.

4.1.3 Sending Extra Scripts to the Router

The Router Configurator sends CONFIG CLI commands regardless of whether
are loading an Extra script, testing an Extra script, or entering commands intera
tively. In each case, the Router Configurator does the following:

1. Starts a Telnet session to the router console

2. Runs CONFIG, and uses TFTP to load the information configured in the GU

3. Depending on what you have chosen, either sends an Extra script, or allow
to enter commands interactively

For more information, refer to Section 4.12.1.

4.1.4 Saving an Extra Script

Once you save an Extra script, it becomes part of the router data file. This mean
if you reload a router from the Router Configurator, the last saved Extra script w
automatically be Telneted to the router, after the GUI configuration has been loa

In addition to saving an Extra script in the router data file, you can save it in a te
file; refer to Section 4.10 for details.

4.2 Overview of the Extra Page

This section gives an overview of the facilities offered on the Extra page, and ho
use them.

4.2.1 How to Get to the Extra Page

To go to the Extra page, click Extra on the Main Navigation window.
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4.2.2  The Windows on the Extra Page

There are two windows available on the Extra page:

• The Extra Commands Script window

• The Router Dialog window

4.2.2.1 The Extra Commands Script Window 

The first window you see on the Extra page is the Extra Commands Script window; 
see Figure 4–1. You use this window to type or paste in CLI commands, or spe
existing CLI script files. When you click the Close button, the contents of the win-
dow is saved as part of the router data file.

The Run Script button lets you test an Extra script displayed or specified in the 
Extra Commands Script window. When you click Run Script, the Router Configura-
tor displays the Router Dialog window in Figure 4–2, and then Telnets the Extra 
script to the router. 

Figure 4–1 Extra Commands Script Window
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4.2.3 The Router Dialog Window

You use the Router Dialog window (Figure 4–2) to conduct a Telnet session to the
router console. This window enables you to test the correctness of CLI commands, 
and record the commands. 

The Router Dialog window appears to the right of the Extra Commands Script win-
dow if you do either of the following:

Figure 4–2 Router Dialog Window

• Click Run Script. The Router Configurator displays the Router Dialog window, 
starts a Telnet session, and sends the contents of the Extra Commands Script 
window to the router. The Router Dialog window displays each command as it is 
sent and the response returned by the router. 

• Check the Telnet Window box. The Router Configurator displays the Router 
Dialog window, empty. You can then use the window to Telnet commands to the 
router, and see the router’s responses. You can also record the Telnet sess
the Extra Commands Script window. 
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4.3 Keyword Directives

Keyword directives constitute a simple command language. Their purpose is to ena-
ble an Extra script to run as if were a succession of CLI commands entered interac-
tively.

4.3.1 Viewing Keyword Directives

You will see keyword directives in the following circumstances:

• When you record a Router Dialog Telnet session. The Router Configurator auto-
matically inserts keyword directives between the CLI commands displayed in 
the Extra Commands Script window; see Figure 4–3.

• In the example Extra script files provided with the Router Configurator kit; see 
Section 4.6.3.

4.3.2 Using Keyword Directives

There are some circumstances in which you need to insert keyword directives your-
self. These are: 

• If you create an Extra script by typing commands into the Extra Commands 
Script window, rather than recording them from the Router Dialog window.

• If you create an Extra script yourself, outside the Configurator, without using an 
example script.

• You wish to modify a script to add control features or error checking.

The keyword directives that you might use or see are listed in Table 4–1.

Table 4–1 Keyword Directives 

Keywords Description

{! comment}
where comment is your comment 

If the first character after the opening brace is ! 
then the contents are ignored. 

{INDIRECT,File-name} 
where File-name is the name of an 
Extra script file.

This specifies an Extra script file to be executed. 
To specify more than one script file, repeat the 
keyword directive with the new file name.

{SEND,Text} Text specifies text to be sent. This is useful for 
sending control characters. For example, Ctrl P is 
{Send,^P}
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4.4 Using the Extra Page

The Extra page enables you to create and test Extra scripts of CLI commands, and 
save them in the router data file. This section describes how the Extra page enables 
you to do this.

4.4.1 Methods for Creating, Testing, and Saving Extra Scripts

There are three methods you can use to create, test and save Extra scripts:

Keywords Description

{GAPTIME,timeout-value}
where timeout-value is a period of 
time, in milliseconds.

This sets a default time-out value. By default, the 
Configurator will wait this amount of time between 
sending each line of CLI command text. Note that 
this value may be overruled by another keyword 
directive.

{WAITFOR,time,label,text}
where:
time is a period of time, in millisec-
onds.
label is text marking a location in the 
script to be used for error handling
text is text expected from the router.

This tells the Configurator to wait before sending 
the next line in the script until the router returns 
some text that matches text - for example, a com-
mand prompt. If the period specified by time 
elapses without receiving the text, the Configurator 
will go to the point in the script where a keyword 
directive {:label} appears.

{:label}
where :label is text.

This marks the destination for another keyword 
directive, such as WAITFOR.

{GOTO,label}
where label is text marking a location 
in the script.

This tells the Configurator to go to the point in the 
script where the keyword directive {:label} 
appears.

{PAUSE,time}
where time is a period of time, in milli-
seconds.

Causes the script to wait for the specified number 
of milliseconds

{DISCONNECT} This disconnects the Telnet session

{END} This stops or completes script execution. 

{EXT_DISCONNECT} This directive is used if it is expected that the ses-
sion to the router will be dropped by an external 
event, such as when the restart command is 
issued. It is like DISCONNECT, except that it 
expects the router to disconnect before continuing.

Table 4–1 Keyword Directives  (Continued)
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• Enter commands interactively in the Router Dialog window while using the 
Record facility. This method helps you to determine correct CLI command syn-
tax by means of CLI prompts and messages. Refer to Section 4.5.2.

• Create an Extra script file outside the Router Configurator. This is referred to in 
this chapter as a prebuilt script. Typically, you would use one or more example 
Extra files as the basis for your script, tailoring the commands for your router. 
Once you have created a prebuilt script, you can test and save it. Refer to Section 
4.6.

• Type CLI commands in the Extra Commands Script window. It is recommended 
that you do this only if your Extra script is extremely simple.

Refer to the following sections for information you will need when creating Extra 
scripts:

• Keyword Directives, Section 4.3

• Advice on Creating Extra Scripts, Section 4.7

4.5 Entering Commands Interactively

This section describes how to use the Router Dialog window to conduct a Telnet ses-
sion with the router console, and record the commands you enter. 

4.5.1 Before You Begin

Before you go to the Extra page, be sure to complete the GUI configuration.

4.5.1.1 Connecting to the Router

Before you connect to the router, you should check the following:

• If you want to test the CLI commands on a router other than the one you are con-
figuring, specify a surrogate router, as described in Section 4.11. 

• Check that the router you use for testing is connected to the network and is 
reachable from the PC.

• After you connect to the router, the CONFIG utility is automatically started. If 
CONFIG was run on the router previously, you should check that its last prompt 
was either the Config> prompt or an interface or protocol prompt (for example 
IP Config>. If its last command was not completed - that is, it was still ask-
ing for a parameter - then script execution may fail.
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4.5.2 Recording a Router Dialog

To record the commands in the Router Dialog window, click the Record button. 

Figure 4–3 Recording CLI Commands

Record does not record the complete dialog shown in the Router Dialog window. 
Instead, it records in the Extra Script Commands window the script needed to repro-
duce the actions in the Router Dialog window. This script consists of the commands 
you have entered, and the required keyword directives.

4.5.2.1 Example

Suppose that the following dialog is displayed in the Router Dialog window (text 
you enter is in bold):
Config>protocol
Protocol name or number [IP]? IP
Internet protocol user configuration
IP config>add address
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In the Extra Script Commands window, the following record would appear:

{WAITFOR,500,ScriptFail,Config>}
protocol
{WAITFOR,500,ScriptFail,ame or number [IP]? }
IP
{WAITFOR,500,ScriptFail,IP config>}
add address

Figure 4–4 explains the parameters in these keyword directives.

Figure 4–4 Example Keyword Directive

{WAITFOR, 500 ScriptFail,Config>}

Indicates that the Configurator is
waiting 500 milliseconds for the
router to return a prompt.

A label indicating the location in the
script that processing should move to if
the router does not return a prompt.

The text (in this case a prompt)
that the Configurator expects the
router to return.
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4.5.3 Using the Router Dialog Window

The table shows the steps required to create, record and save an Extra script using the 
Router Dialog window. The procedure assumes that the Router Configurator is run-
ning and the Extra page is displayed.

Step Action Result

1. If the Router Dialog window is not 
up, check the Telnet Window box.

The Router Dialog window appears. 

2. Click the Connect button. The Configurator tries to Telnet to the router 
console. If it succeeds, the field showing IDLE 
changes to CONNECT. The Configurator then 
starts CONFIG and uses TFTP to load the 
GUI configuration. See Section 4.12.1 for an 
example of the output.

3. If the Config> prompt does not 
appear, press the Enter key.

The Config> prompt is displayed.

4. Click the Record button. The Configurator starts recording the com-
mands in the Router Dialog window in the 
Extra Commands Script window.

5. Enter a command at the Config> 
prompt. 

The Configurator sends the command to the 
router, and waits for a response - a prompt, or 
a failure message.

6. Repeat Step 5 until you have fin-
ished entering CLI commands. If 
necessary, you can type ? to get 
help.

7. Click the Stop Recording button. The Configurator stops recording commands 
and responses.

Click the Disconnect button. The Configurator ends the Telnet session.

8. Edit the contents of the Extra Com-
mands Script window to remove 
unwanted text, for example, wrong 
commands.

9. Test the script again by clicking 
Run Script.

The Configurator Telnets the complete script 
to the router.

10. When you are satisfied that the 
script is correct and complete, click 
Close.

The Configurator saves the script in the router 
data file.
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4.6 Creating Prebuilt Extra Scripts

You can create an Extra script file outside the Router Configurator, and test and save 
it on the Extra page.

4.6.1 Naming Extra Script Files

It is recommended that you give Extra script file names the extension .SCP. This is 
the default extension used by the Router Configurator.

4.6.2 Testing and Saving Prebuilt Extra Script Files

After creating your Extra script file, you need to test and save it. 

To test your Extra script file, refer to Section 4.8. To save your Extra script file, refer 
to Section 4.9.

4.6.3 Using Example Extra Script Files

The Router Configurator kit includes a number of example Extra script files. The 
simplest way to create Extra scripts for your router is to base your Extra script file on 
one or more of the example Extra files.

4.6.3.1 Location of Example Extra Script Files

The example Extra script files are in the following directories:

installation-directory\SAMPLES
installation-directory\SAMPLES\LIBRARY

where installation-directory is one of the following directories:
– If you installed standalone, the directory where you installed the Router Con

figurator software.

– If you installed under clearVISN, the following subdirectory: 

clearVISN-installation-directory\COMET

where clearVISN-installation-directory is the directory where clearVISN 
was installed.

A complete list of the example files supplied, and some advice on their use, is in
file README.DOC in the directory installation-directory\SAMPLES.
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4.6.3.2 What Is in an Example Script File?

An example Extra script file contains a series of CLI commands, interspersed with 
keyword directives. For example, each CLI command is preceded by a WAITFOR 
keyword directive, instructing the Router Configurator to wait before issuing the 
command until it receives the correct command prompt from the router. 

Each example Extra script file has an accompanying text file containing notes on the 
configuration process.

Example Extra script files have the extension .SCP. Each explanatory text file has the 
same name as the script file it is associated with, except that it has the extension 
.TXT

4.6.3.3 Editing Example Extra Script Files

It is recommended that you do not edit the example script files directly, as it is useful 
to keep them for guidance. Instead, you should make a copy of each example script 
file you want to use, and edit that. 

4.6.4 Creating Extra Script Files

Before you create an Extra script, refer to Section 4.3 and Section 4.7 below.

4.7 Advice on Creating Extra Scripts

This section provides guidelines on creating Extra scripts. It assumes that you are 
creating an Extra script by entering CLI commands interactively in the Router Dia-
log window while using the Record facility, as described in Section 4.5.3.

4.7.1 Requirement

You should be familiar with the syntax of the Distributed Routing Software CLI 
commands. This section does not describe individual commands.

4.7.2 Before You Begin

Before you create an Extra Script, you should do the following:

• Check that you know the commands needed to configure the additional router 
features you want.

• Review the GUI configuration in the Summary window; refer to Section 3.4.4.1 
for more information about the Summary window.
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4.7.3 Creating Modular Extra Scripts

If you have a complex configuration, it is advisable that you break down the Extra 
script into functionally related modules, and store the commands in these modules in 
separate files. This will help to improve the reliability of your scripts and make test-
ing easier.

Creating the Extra script as a set of modules can also be useful if you want to:

• Create modules that can be re-used in several configurations.

• Enforce shared or standard settings on multiple routers. In this case, each Extra 
script an individual router would include a common script module that produces 
the same set of policies or settings for all the routers. 

4.7.3.1 Checklist for Creating Modular Extra Scripts

Before you create the modules that will make up your final Extra script, you should 
consider the following:

• What the major components are in your configuration

• What files you want to produce and where they will be stored

It is good practice to form a directory structure in which you can easily find 
the scripts and components needed. At the very least, it is advisable to create 
a subdirectory for your script files underneath the location for the Router 
Configurator software.

• Where each of the scripts will start and stop

When you produce modular scripts you should make sure that they all begin 
and end processing at a standard command prompt. All example Extra script 
files supplied expect to start processing at the Config> prompt.

4.7.3.2 Procedure for Creating Modular Extra Scripts

This section goes through the steps needed to create an Extra script consisting of a 
number of script file modules. For each module, do the following:

1. Follow the steps in the table in Section 4.5.3, through step 9.

2. When the script module runs without errors, remove the generated labels at the 
end of the script text - that is, the text beginning at {GOTO,ScriptExit}. This is 
error handling text, which only needs to appear once in the top level script. If it is 
left in all script modules, it will cause a duplicated label error.
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3. Save the script to a file, as described in Section 4.10. Clear the window, by 
selecting Clear Window on the Edit menu.

4. Repeat steps 1 to 3 until you have produced all of the script file modules needed 
for your router. 

5. Test the top level Extra script. To do this, type a series of {INDIRECT,} direc-
tives in the Extra Commands Script window (described in Section 4.8.2.1). Then 
click Run Script. 

6. Finally, save the top level Extra script in the router data file by clicking Close.

Note: Make sure the error handling text appears in one of the script modules, in 
a suitable location. You could place it:

• At the end of the last script module in the series

• In a script module file of its own, to be run last

• As text in the Extra Commands Script window

4.7.4 Editing a Recorded Extra Script

This section gives advice on editing the recorded script.

4.7.4.1 General Advice

You will need to edit the Extra script to do the following:

• Remove unwanted responses (for example, help text or error messages).

• Remove incorrect or unwanted commands (for example, the ? entered to get 
help).

• Add or modify keyword directives. For example, you may want to change the 
time the Configurator will wait for responses. Also, see Section 4.7.4.2 below.

4.7.4.2 Constructing Reliable WAITFOR Keyword Directives

The purpose of the WAITFOR directive is to check that the correct response is 
received from a router before the next CLI command is sent. It is important that you 
construct the WAITFOR directive so that it makes these checks reliably.

Each WAITFOR directive includes a text string indicating the prompt expected from 
the router in response to the last command. If the prompt actually received does not 
match the “expected text” in the WAITFOR directive, the script fails, with an erro
If it does match, the next command is sent.
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In order to match the text specified in the WAITFOR directive, the router’s respo
must include the entire text string specified in the WAITFOR directive. However,
response is allowed to contain additional characters. For example, the router 
response timer in minutes [10]? will match a WAITFOR directive with the text por-
tion timer in minutes.

When you create a script using the Record facility, the Router Configurator will gen-
erate the required keyword directives, including WAITFOR directives. Each WA
FOR directive will contain as its “expected text” the last 20 characters of the exa
response received to the command it follows. 

For example, in the table below, the user enters a set inactivity command. The Con-
figurator takes the last 20 characters of the response (mer in minutes [10]?) and 
inserts it into the WAITFOR directive as the expected text string. 

However, this can cause problems when the router response includes a preconf
default. For example, the WAITFOR directive in the table shows that it expects 
prompt including the characters [10]? However, if this script were sent to a router 
which had a different default, or no default, the WAITFOR directive would not ge
its expected response, and the script will fail.

To overcome this sort of problem, make sure that specific defaults are removed
any recorded scripts. The table below shows how you might achieve this. 

Commands Entered Resulting Script

Config>set inactivity set inactivity

Console inactivity timer in minutes [10]? 
20

{WAITFOR,1000,ScriptFail,mer in minutes 
[10]?} 20

{WAITFOR,1000,ScriptFail,Config>}

Generated Script Edited Script

set inactivity set inactivity

{WAITFOR,1000,ScriptFail,mer in minutes [10]?} {WAITFOR,1000,ScriptFail,timer in min-
utes}
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4.8 Testing CLI Commands and Extra Scripts

This section describes how to test CLI commands and Extra scripts. Before you do 
any testing, check the notes in Section 4.12.

4.8.1 Testing CLI Commands in the Extra Commands Script Window

To test a series of CLI commands that you have recorded, typed or pasted in the 
Extra Commands Script window, click Run Script. 

Result: The Router Configurator loads the GUI configuration, and then Telnets the con-
tents of the Extra Commands Script window to the router.

4.8.2 Testing a Prebuilt Extra Script

There are two ways to test a prebuilt Extra script:

• Specify one or more script files using the { INDIRECT...} keyword directive.

• Use the Run Script File option.

4.8.2.1 Using {INDIRECT} Keyword Directives 

Follow these steps:

1. Type the following in the Extra Commands Script window:

{INDIRECT,filename}

where filename is the name of your script file.

To specify several example scripts, enter a series of {INDIRECT} directives, 
each on a new line.

2. Click Run Script.

Result: The Router Configurator reloads the GUI configuration, and then Telnets the 
specified script(s) to the router.

4.8.2.2 Using the Run Script File Option

You can only specify one file with this method. Follow these steps:

1. Bring up the Router Dialog window, by clicking the Telnet Window box.

2. Click the Run Script File button. The Select Script File to Send window 
appears. 

3. Select or enter a script file name. Click OK.
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Result: The Router Configurator Telnets the specified script to the router. Note: the Con-
figurator does not reload the GUI configuration. 

4.9 Saving an Extra Script

This section summarizes the methods you use to save an Extra script to the router 
data file.

4.9.1 Saving the Contents of the Extra Commands Script Window

To save a series of CLI commands that you have recorded, typed or pasted in the 
Extra Commands Script window, click the Close button.

4.9.2 Saving a Prebuilt Extra Script

Follow these steps:

1. Type the following keyword directive in the Extra Commands Script window:

{INDIRECT,filename}

where filename is the name of your Extra script file.

To specify several example scripts, enter a series of {INDIRECT,} keyword 
directives, each on a new line. 

2. Click the Close button.

If you are saving a number of Extra script file modules, so that they will make up one 
top level script, check that you have followed the steps in Section 4.7.3.2.

4.9.2.1 How the Router Configurator Saves Prebuilt Extra Scripts

In the case of the prebuilt script files specified in {INDIRECT,} keyword directives; 
the Router Configurator saves the pointers to the specified file names, rather than the 
contents of the script files. This means that you can modify script files without need-
ing to save them again in the Configurator.

4.9.3 Result of Saving Extra Scripts

When you click the Close button, the Router Configurator saves the contents of the 
Extra Commands Script window to the router data file. 
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Once the scripts are saved in the router data file, the Router Configurator considers 
them part of the router’s configuration. This means that it will automatically Teln
the commands to the router whenever you load the router from within the Config
tor.

4.10 Saving Commands in a Text File

You can save either selected text, or the entire contents of the Router Dialog win
or the Extra Commands Script window to a text file. 

Follow these steps:

1. To save selected text, select Save Selected Text on the Edit menu.

To save the entire contents of the a window, select Save Window As on the 
Edit menu. The Configurator will save the active window - that is, the one 
that the cursor is in.

The Save Window to File window appears. 

2. Enter or select a file name. Give the file name the extension .SCP.

3. Click OK. 

4.11 Using a Surrogate Router

You can, if you wish, specify a surrogate router for testing CLI commands - that 
router other than the one you are configuring. There are two main reasons for us
surrogate router for testing:

• If the router you are configuring has not been configured previously. In this case, 
you must use a surrogate router for testing, because a router will only respond to 
CLI commands if it contains a configuration.

• Generally, to allow you to produce and debug your router configuration without 
affecting other users of the network. 
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4.11.1 How Testing Works

You can use a surrogate router for testing without changing  its current active config-
uration, or permanently altering the configuration in nonvolatile memory. The next 
sections explain how this works. 

4.11.1.1 Background

Each DRS router holds two configurations at the same time:

• The permanent configuration in nonvolatile memory.

• The active configuration in volatile memory. This is the configuration the router 
is actually using.

You create the permanent configuration by loading a Router Configurator configu-
ration file, by running CONFIG interactively and entering Talk 6 commands, or 
both. This permanent configuration only becomes the active configuration when you 
restart or reboot the router.

This means that the commands you enter interactively using CONFIG do not take 
effect immediately. However, they are checked for syntax errors.

4.11.1.2 What Happens When You Test

When you test CLI commands on a surrogate router, the configurator:

1. When you connect to the surrogate router on the Extra page, saves the surrogate 
router’s permanent configuration in a file on the PC.

2. Sends the CLI commands to the surrogate router, as descibed in Section 4.

3. When you disconnect, restores the surrogate router’s permanent configurat

4.11.2 Requirements for Using a Surrogate Router Successfully

In order for you to use this feature successfully:

• You must have exclusive access to the surrogate router while you create or mod-
ify the Extra script interactively, so that no one else can modify the surrogate 
router’s permanent configuration while you are testing .

• You must ensure that the surrogate router cannot interact with the real router 
which will eventually be loaded with the configuration.  
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4.11.2.1 Using a Surrogate on a Private LAN

One way to achieve these conditions is to use a second network adapter on your PC 
to create a private LAN, as shown in Figure 4–5. You can then use the surrogat
router to experiment with a configuration and incrementally change it without affect-
ing the real network and its users. 

Figure 4–5 Surrogate Router on a Private LAN

Note: Do not restart the surrogate router during testing. If you do, the result 
may be that the surrogate router and the router  you are configuring have 
the same configuration (including the same IP management address).

4.11.3 Procedure

To specify a surrogate router, follow these steps:

1. On the Load menu on the main menu bar, select Options.

2. The window in Figure 4–6 appears. Check the Use a surrogate router box.

3. Enter the IP address of the router you want to use as the surrogate. 

4. Click OK.
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Figure 4–6 Preferences for Load/Extra Commands

4.12 Connecting to the Router

When you click either the Connect button or the Run Script button, the Router Con-
figurator attempts to put the router in the same state that it would be in if you were 
actually loading a configuration. It does this by using TFTP to load the GUI configu-
ration for the router. The purpose of this is to ensure that:

• The router can respond sensibly to the CLI commands. 

• The CLI commands will be compatible with the rest of the configuration.
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4.12.1 What Happens When Connecting to the Router

When you click Connect or Run Script, the router displays these prompts:

Copyright 1995-1996 Digital Equipment Corp.
MOS Operator Control

+----------------------------+
| Preparing - Please wait... |
+----------------------------+
*
*
*talk 6

Config>exit
 Command error
Config>exit
 Command error
Config>exit
 Command error

Config>boot
TFTP Boot/dump configuration
Boot config>TFTP PUT CONFIG 16.39.160.186
host filename [102410A2.cfg]? C:\COMET\
rfa00069.SRx
TFTP transfer complete, status: OK

Boot config>
Boot config>TFTP GET CONFIG 16.39.160.186
host filename [102410A2.cfg]? C:\COMET\
rfa00069.SRM
TFTP transfer complete, status: OK
Configuration file originated on host
named:"raew"
- is this okay ? (Yes or [No]): yes
Updating CONFIG; Do Not Interrupt!

Boot config>exit
Config>
Config>
+------------+
| SUCCESSFUL | (Replay)
+------------+
*

}

2. Enters Exit three times.
This takes you to the
Config> prompt if
CONFIG was displaying a
protocol or interface
prompt from a previous
session.

3. Loads the GUI
configuration, using
TFTP.

4. Returns to CONFIG>

1. Starts CONFIG
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Using the Telesaving Monitor

5.1 Introduction 
Telesaving refers to a set of features and working practices whose aim is to maximize 
the bandwidth available on router dial circuits while reducing costs as much as 
possible. 

Two major features of Telesaving are Budgeting and Scheduling. You can set up 
both of these features in the Router Configurator.

The Telesaving Monitor is a Web-based tool that lets you monitor Budgeting and 
Scheduling information, as follows:

• Budget usage. The Telesaving Monitor provides a graphical representation of the 
amount of Budget allocation currently being used by your routers.

• Budget and Scheduling information about your router. This information is  
recorded by the Telesaving MIB, which is installed with the Router Configurator 
software.

In addition, you can use the Monitor to change some of the Budget characteristics.

5.1.1 Requirements for Using the Telesaving Monitor

In order to use the Telesaving Monitor to monitor or change a router, the following 
requirements must be met:

• The router must have Dial circuits configured.

• The router  must have Telesaving features configured. See Section 5.2.

•  The Telesaving Monitor  must be able to reach the router over the IP network. 

5.1.2 Budgeting  

The Budgeting feature enables you to configure budgets for the router and allocate 
percentages of the overall budget to individual dial circuits. 
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A budget is defined as either of the following:

• A total amount of connection time within a given period

• A total number of charge units. 

You can also specify the action to be taken when dial circuit usage reaches the 
budget limit. For example, you can specify that incoming and/or outgoing calls be 
blocked, or that there should be an error recorded in the Event Log System. 

5.1.3 Scheduling 

The Scheduling feature enables you to configure profiles for call blocking, call-back 
and initial minimum timers.

• Call-Blocking Profile. You use this to prevent, or permit, incoming and outgoing 
calls at certain times of the week

• Call-Back Profile. You use this to enable the router to call back a remote system 
when accepting an incoming call, or to request call-back when it makes an out-
going call during specified periods.

• Initial Minimum Timer profile. This  specifies how long a dial circuit will be 
kept connected when it has just been set up. The main purpose of this timer is to 
use time which has already been paid for.

5.2 Setting Up Telesaving Scheduling and Budgeting

This section briefly describes how to configure Telesaving in the Router 
Configurator. Refer to the on line help for full details.

5.2.1 Types of Circuits Supported

You can configure the following types of circuits for Telesaving in the Configurator:

• ISDN dial circuits

• PPP/frame relay dial circuits over serial lines.

• PPP/frame relay dial circuits over ISDN dial circuits

• V.25bis dial circuits

In addition,  you can configure Telesaving for Multilink bundles with dial circuits 
and WAN restoral secondary circuits.
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5.2.2 Procedure

To set up Telesaving on a router in the Router Configurator, follow these steps:

1. Open the router’s configuration and select Interfaces on the Main Navigation 
window.

2. On the Interfaces tab page, configure one or more dial circuits.

3. Double-click the Telesaving icon on the Interface tree. There are two icons under 
it: one for Scheduling and for Budgeting.

4. If you want to configure Scheduling, double-click the Scheduling icon, and ente
information on the tab pages.

5. If you want to configure Budgeting, double-click the Budgeting icon , and en
information on the tab pages.

6. Now, select a dial circuit that you want to configure for Telesaving.

7. Enter information on the dial circuit’s Telesaving tab page. You may need to
scroll to see this tab page.

8. Repeat steps 6 and 7 for each dial circuit on which you want Telesaving.

9. Click OK.

5.3 Installing the Telesaving Monitor

You install the Telesaving Monitor when you install the Router Configurator. Re
to Section 2.5 for details.

5.4 Starting the Telesaving Monitor

To start the Telesaving Monitor, you must have have a standard Web Browser 
installed. 

There are two ways to start the Telesaving Monitor:

• From the Start menu, choose: 

Programs Ð Digital Configurators Ð Telesaving Monitor

This starts up your Web browser.

• From your Web browser, enter the URL of the Telesaving Monitor. This is the 
URL you entered in the Web field during installation, with /Telesaving.html 
added at the end. 
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For example, if the Web field is:

http://fred.webfield.com 

you would need to change it to

http://fred.webfield.com/Telesaving.html

5.5 Using the Telesaving Monitor

When you start the Telesaving Monitor, you will see a list of the routers that have 
been configured for Telesaving using the Router Configurator. 

1. Click  the router that you want to view. When the Monitor has connected to the 
router, the Budget usage display for the router will appear. For example:

Figure 5–1 Budget Usage Display 

2. To view further details, click the Start button. The Monitor will then start  
polling the router for Budget usage, and update the display every 5 seconds.

If you do not want the Monitor to poll the router continuously, click the 
Refresh button instead of the Start button. The Monitor will poll the router 
once and update the display; it will not poll continously.

3. To view the Budgeting and Scheduling information:
5–4



Using the Telesaving Monitor
5.5  Using the Telesaving Monitor
• Click on the bar next to Overall to see the router-wide details.

• Click on the bar next  to a Circuit to see the circuit’s details

The details you will see are all objects of the Telesaving MIB. 

For example, if you click next to Overall, the first page of the display would be 
similar to Figure 5–2.

Figure 5–2 Router Details Display
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5.5.1 Getting Help

You can get information about the meaning of the Budget and Scheduling details as 
follows:

• For a general explanation of  Budgeting and Scheduling, click Help at the foot of 
the page of the Budget Usage display (Figure 5–1).

• To see an explanation of  a particular object, click on any of the objects in the 
Details display (see Figure 5–2).

•  The full text of the Telesaving MIB is provided on the Distributed Routing Soft-
ware V3.0 CDROM supplied with your router. The name of the file is:

telesaving-mib-v1-0.txt

5.6 Using the Monitor to Change Characteristics

You can change some of the router’s characteristics from the Telesaving Monito
Follow these steps:

Step Action Result

1. Start the Telesaving Monitor as 
described in Section 5.4. Click a 
router in the list. 

You will see a display similar to Figure 
5–1.

2. On the display, click the Reset 
button

The Reset window will appear; see 
Figure 5–3 for an example. All the 
fields below Community repesent 
Budget MIB objects that you can 
change.

3. Next to Community, enter the 
name of an SNMP community with 
get/set access which has been set 
up on the router.

You will be allowed to make changes 
in the Reset window.

4. Make the changes in the Reset 
window. When you are finished, 
click OK.

The Monitor will issue SNMP gets to 
make the changes on the router. Note 
that the changes will have no effect on 
the configuration saved in the Router 
Configurator. 
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Figure 5–3 Reset Window

Descriptions of the MIB objects in the Reset window are as follows:

Object Description

Budget Status This indicates whether Budget controls have been 
enabled or not. 

Budget period This indicates how often the budget is refreshed. You 
enter it as a number of hours. 

Budget Charge Units This indicates the number of D-channel charge units that 
represent the available Budget. Note that a Budget is 
repesented either  as charge units or as time; not both.
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Budget Time This indicates the number of minutes of connect time 
allocated for each Budget period. Note that a Budget is 
repesented either as charge units or as time; not both.

Budget Overdraft Units This indicates the number of charge units available from 
an overdraft account.

Budget Overdraft Time This indicates the number of minutes of connection time 
available as an overdraft during a given budget period.

Threshold Percentage This indicates the percentage of the budget that can be 
spent before activating the threshold alarms. This object 
is used to give early warning that spending has reached a 
certain percentage of the allocated budget.

Threshold Alarm Action This shows the action to be taken once the defined 
threshold percentage has been spent.The  options are: 
log events, log SNMP traps, log both, or no action.

Call Policy Action This defines the Call Blocking action that will taken once 
the Budget (including the overdraft) has been spent. The 
possible actions are: block none, block incoming only, 
block outgoing only, or block both incoming and outgoing.

Packet Policy Action Not currently supported.

Budget Check Interval This shows, in minutes, how frequently the Budget will be 
checked and recorded into nonvolatile memory (which 
enables the Budget to be tracked over power failures and 
reboots). 

Budget Scope This indicates which types of calls (incoming, outgoing or 
both) are included in the calculation for Budget usage

Object Description
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Version 2.0 and later of the Distributed Routing Software includes the EasyStart 
facility. Easystart enables a router to do the following: 

• Act as a BOOTP client when it has no configuration information available. This 
eliminates the need to use the console setup port to provide initial configuration 
information.

• Download its configuration file from a host using the TFTP protocol.

EasyStart can send and receive BOOTP messages on all LAN interfaces, and on PPP 
and Proteon Serial Line (PSL) WAN interfaces.

The System Software Guide gives a detailed description of EasyStart. This chapter 
describes how the Router Configurator supports EasyStart BOOTP, and the steps 
needed to configure the router’s WAN interfaces for BOOTP.

6.1.1 About BOOTP

BOOTP is a protocol used by a router (or other diskless system) to learn its IP 
address and the location of its load file. A router sending BOOTP requests to fin
this information is a BOOTP client. The host that holds the information and can 
respond to BOOTP requests is a BOOTP server.

A BOOTP server holds a list of the BOOTP clients it is responsible for. This list 
known as a BOOTP database. The BOOTP database contains each client’s IP 
address, hardware address (sometimes called a MAC address), and the locatio
file to be loaded; it may also contain other information. To find a client’s IP addre
the BOOTP server matches the hardware address in the client’s BOOTP reque
hardware address in the BOOTP database, and then finds the IP address asso
with the hardware address.
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6.1.2 EasyStart and the Router Configurator

The Router Configurator does the following to support EasyStart:

• Provides BOOTP server software. This enables the PC on which it is running to 
act as a BOOTP server.

• Sets up a BOOTP database on the PC, and creates entries for configured routers. 
It creates one entry for each router interface used for BOOTP.

• Provides a tab page to configure PPP and PSL interfaces for BOOTP.

6.2 Setting Up BOOTP for LAN Interfaces 

The Configurator automatically creates an entry in the BOOTP database for each 
LAN interface, using information taken from the General tab page under System. 
You do not need to enter any information for BOOTP on LAN interfaces, other than 
the mandatory information on the General tab page.

6.2.1 LAN Interface Information in the BOOTP Database

The router configurator enters the following information in the BOOTP database for 
each LAN interface:

• The hardware address for the interface. This is taken from the hardware address 
on the General tab page. If there is only one LAN interface, the hardware 
address is identical to the hardware address. If there is more than one, the hard-
ware address for an interface consists of the first 11 digits of the hardware 
address and, for the twelfth digit, the port number of the interface.

• The IP address of the router. This is the in-band IP address on the General tab 
page. The IP address is the same for each LAN interface. 

• The location of the configuration file. This is the file created by the Configurator 
and loaded to the router.

6.3 Setting Up BOOTP for WAN Interfaces

To set up WAN interfaces to use BOOTP, you enter information on the BOOTP 
EasyStart tab page under System. 
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6.3.1 The BOOTP Protocol and WAN Interfaces

BOOTP is generally not implemented over WAN interfaces, since WAN interfaces 
do not use hardware addresses. However, EasyStart provides a special format for 
WAN interface hardware addresses that allows the router to use BOOTP over WAN 
interfaces. In the Router Configurator, you provide the information required to con-
struct the special format hardware addresses for WAN interfaces. 

6.3.2 Requirements for Using BOOTP on WAN Interfaces

To use BOOTP over WAN interfaces, the following requirements must be met:

• The WAN interfaces must be connected to a BOOTP relay agent that can com-
municate with the BOOTP server .

• The WAN interfaces on the router and on the BOOTP relay agent must be run-
ning either PPP or the PSL protocol. 

• Each BOOTP WAN interface on the BOOTP relay agent must have an IP 
address.

6.3.3 Procedure

To set up BOOTP WAN interfaces in the Router Configurator, follow these steps:

1. Make sure that the WAN interfaces that you want to use for BOOTP are config-
ured to use PPP or PSL.

2. Go to the EasyStart BOOTP tab page under System. For each WAN interface 
to be used for BOOTP, do the following:

a. Select the interface in the list box on the left.

b. If you wish, enter a description of the interface.

c. Check the Enable box. 

d. In the IP address box, enter the IP address of the BOOTP relay agent WAN 
interface to which this interface connects.

To prevent an interface from being used for BOOTP, leave the IP address as 0.0.0.0.

6.3.4 WAN Interface Information in the BOOTP Database

The router configurator enters the following information in the BOOTP database for 
each WAN interface :
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• The hardware address for the interface. This is a special format hardware 
address, based on the IP address of the BOOTP relay agent interface to which 
the router’s WAN interface connects. 

• The IP address of the router. This is the same as for LAN interfaces.

• The location of the configuration file. This is the file created by the Configurator 
and loaded to the router.

6.4 The Router Configurator and BOOTP Servers

 BOOTP server software is included with the Router Configurator. If the Configura-
tor is running standalone, it automatically starts its BOOTP server when you load the 
router (unless the BOOTP server is running already).

If the Configurator is running as part of the clearVISN package, the Router Configu-
rator uses the BOOTP server provided by clearVISN.

6.4.1 Running the BOOTP Server Independently

If you are running the Router Configurator standalone, you can run the Router Con-
figurator’s BOOTP server independently. 

To start the BOOTP server, just click on the BOOTP server icon in the Digital R
ers program group. If you want the BOOTP Server to start automatically when y
start up your PC, move the BOOTP server icon to your startup program group.

6.5 Viewing the BOOTP Database

To view the BOOTP database, go to the View menu and select

BOOTP Database Viewer  Ð Display BOOTP Database

The current BOOTP database will be displayed.

6.6 Adding an Entry to the BOOTP Database

To add your own entries to the BOOTP database:

1. If you are not already viewing the BOOTP database, go to the View menu and 
select BOOTP Database Viewer  Ð Display BOOTP Database

2. Select  BOOTP Database Viewer  ÐAdd BOOTP Entry
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The Router Configurator automatically sets up BOOTP entries in the BOOTP data-
base for each router you configure, provided that Use BOOTP is checked on the 
Router menu. The Add BOOTP Entry option lets you add entries for other routers 
- for example, if you want to use your PC as a BOOTP server for routers not sup-
ported in the Router Configurator.

6.7 Turning Off BOOTP for a Router

To prevent the Router Configurator from setting up an entry for a router in the 
BOOTP database, follow these steps:

1. In the Browser, select a router configuration.

2. On the Router menu, you will see the Use BOOTP option. If it is ticked, click on 
it to remove the tick. If it is not ticked, BOOTP has already been turned off for 
that router.
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Loading the Router

This chapter describes how to use the Router Configurator to load the router.
n in-
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7.1 Requirements for Loading the Router

The router you are going to load must meet the following requirements:

• Its software must be installed.

• The router must have an IP address. If the router is new, or its configuration 
information has been cleared, it will not have an IP address. 

There are two methods for giving a router an IP address, depending on the 
Distributed Routing Software (DRS) version:

– For Version 1.1 or earlier, you must use the console setup port to enter a
band IP address and, if necessary, a gateway IP address. Refer to Sect
2.6.1.

– For Version 2.0 or later, the EasyStart facility enables the router to act as a 
BOOTP client, and obtain its IP address from a BOOTP server on the n
work. Refer to Chapter 6 for more information about EasyStart.

• You must be able to reach (ping) the router from the PC over the network. 

7.2 Steps in Loading: DRS Version 1.1 or Earlier

The basic steps are as follows:

1. If the router does not have an IP address, use the router’s setup port to ente
in-band IP address and, if necessary, a gateway IP address.

2. Use the Router Configurator to create or modify a configuration.

3. If you wish, configure Load Options, as described in Section 7.4.

4. Click the Load button on the Main Navigation window. 

If you wish to load the router at a later time, click Close instead of Load.
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7.3 Steps in Loading: DRS Version 2.0 or Later

The basic steps are as follows:  

1. Use the Router Configurator to create or modify a configuration.

If you want the router to run BOOTP over its WAN interfaces, enter infor-
mation on the BOOTP EasyStart tab page (under System). Refer to Section 
6.3 for details.

2. If you wish, configure Load Options, as described on Section 7.4.

3. Click the Load button on the Main Navigation window. 

If you wish to load the router at a later time, click Close instead of Load. As 
well as saving the configuration file, this creates BOOTP entries for the 
router.

4. If necessary, clear and restart the router. Refer to the System Software Guide for 
instructions on how to do this.

7.3.1  Loading Without Using the Configurator

If the BOOTP server is running, you can load a router without using the Configura-
tor. Follow these steps:

1. Follow steps 1 and 2 in Section 7.3.

2. Click the Close button on the Main Navigation window.

3. When you wish to load the router, do the following:

a. Make sure the BOOTP server is running on the PC.

b. Clear and restart the router. Refer to the System Software Guide for instruc-
tions on how to do this.

The router will load the configuration that is held on the PC.

7.4 Setting Load Options

To set load options, select Options from the Load menu. The Router Configurator 
displays the Preferences for Load/Extra Commands window.

There are two Load options:
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• Ask before a router restart. When you request a load, the Configurator by 
default restarts the router to enable the new configuration to take effect. If you 
tick this box, the Configurator will ask for confirmation before restarting the 
router.

When you restart the router, it is temporarily removed from the network.

• Failover connections to secondary addresses. When you load the router, the  
Configurator tries to load the configuration to the in-band IP address specified 
for the router. If this fails, by default, the Configurator gives up the attempt to 
load.

If you tick this box, then, if a load to the in-band IP address fails, the Config-
urator will try to load to each IP interface address in turn.

7.5 Result of Requesting a Load

7.5.1 Records and Files Created

When you click the Load button (or the Close button), the Configurator does the fol-
lowing: 

• Creates a binary (SRAM) configuration file for the router. This file contains the 
information you have entered on the GUI tab pages, plus default parameter val-
ues supplied by the Router Configurator. This is the configuration file initially 
loaded to the router.

• Saves the router’s configuration in the router data file.

• Creates entries for the router’s BOOTP interfaces in the BOOTP database. T
entries include the location of the SRAM configuration file.

7.5.2 Loading the Router

Once the Configurator has created the configuration file and BOOTP entries, it 
the following:

1. Telnets to the router, and starts the CONFIG utility.

If the Configurator cannot connect to the router (for example, because the 
router has not yet learned its IP address), it waits until the router is reacha-
ble.

2. From the BOOT CONFIG> prompt, issues a TFTP get request from the router to
the PC, requesting that the configuration file be loaded.
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 a 
3. If the configuration file loads successfully, Telnets the Extra script to the router.

4. Restarts the router.

5. Once the router is restarted, Telnets to the router and starts the CONFIG utility 
again.

6. From the BOOT CONFIG> prompt, issues a TFTP put request to copy the com-
plete router configuration back to the PC. 

The complete router configuration consists of an SRAM file containing both 
the GUI configuration and the SRAM version of the Extra script. 

7.6 Configuration File Names

Once the Router Configurator has loaded a router, there are two SRAM configura-
tion files for the router:

• The file created from the GUI configuration. This is the file initially loaded to 
the router, after you have created or modified a configuration. The name of this 
file is:

file-name.SRM

where file-name is the router’s configuration name

• The complete router configuration copied back to the PC after the router is 
loaded. This contains both the GUI configuration and the SRAM version of the 
Extra script. The name of this file is:

file-name.SRV

where file-name is the router’s configuration name

7.6.1 Viewing the Progress of a Load

The Router Configurator displays a Load window during the load. This indicates the
progress of the load. If the Configurator cannot connect to the router, it displays
message giving possible reasons.

7.6.2 Cancelling a Load

To cancel a load, click Cancel on the Load window.
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7.7 Reloading an Existing Configuration File

Once you have loaded a router, the Router Configurator copies the entire loaded con-
figuration back to the PC. This configuration is a binary SRAM file, consisting of:

• The SRAM created by the Router Configurator from the information entered on 
the tab pages - that is, the GUI configuration

• The SRAM version of the CLI commands in the Extra script (if any)

You may want to reload this new configuration file at some point. 

7.7.1 Loading a New Router

If you are loading a new router, it is recommended that you do not start the router 
until after you have clicked the Load button or the Close button. The reason for this 
is as follows:

As soon as you start the router, EasyStart sends BOOTP requests to find the ro
IP address. In order for it to find the IP address, there needs to be a BOOTP dat
entry for the router on a BOOTP server host. However, the Configurator only cre
a BOOTP database entry for a router when you click the Load or Close button This 
means that EasyStart will not be able to find the router’s IP address until after y
have clicked Load or Close. If EasyStart BOOTP cannot find the address within 5
minutes, it gives up sending BOOTP messages.

Clicking the Load or Close button before starting the router avoids this problem. A
first, the Router Configurator will find the router to be unreachable, until it learns
IP address. However, this does not matter, as the Router Configurator Load fac
will simply ping the router at intervals until it eventually becomes reachable. 

7.8 Loading a Router Using an Out of Band Management 
Address

This section describes a method for loading a router using an out-of-band mana
ment (OBM) IP address. Normally, the Configurator uses the router’s in-band m
agement IP address for loading.  

With this method, you can use any of the following as an OBM IP address:

• The OBM IP address entered at the setup port during the initial configuration of 
the router. This OBM IP address is associated with the router’s OBM port.

• Any IP address associated with a serial interface.
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7.8.1 About OBM Management

The OBM port gives you an alternative method for managing the router --for exam-
ple, if there are network problems and you cannot use in-band management. You can 
connect a console to the OBM port using a modem or a direct connection. You can 
then use the Serial Line Internet Protocol (SLIP) to communicate with the router. 

7.8.2 Loading Using the OBM IP Address

To load a router using the OBM IP address, follow these steps: 

.
Step Action Result

1. In the Configurator, open the saved config-
uration that you want to load. 

The Main Navigation window 
appears. The menu bar shows the 
Load menu.

2. On the Load menu, select Options. The Options window appears.

3. On the Options menu, do the following:

• Check the box, Use a surrogate router 
as telnet target system.

• Enter the out-of-band IP address as the 
Address of the Surrogate system

• Click OK.

The out-of-band management 
address will be the address used for 
loading the next time the router is 
loaded.

4. Click the Extra button on the Main Naviga-
tion window (or bring the Extra page to the 
top if it is already open). 

The Extra page appears.

5. On the Extra page, click the Run Script 
button

The Configurator Telnets the script to 
the router, using the OBM manage-
ment address..

6. When the script has completed, go to the 
Router Dialog window, and press Return 
until you get the * prompt. Then  type the 
following commands:

Control-P 
Restart (followed by return) 
Yes (followed by return)

The Router configurator loads the 
router  with its configuration, using the 
OBM management address.

7. Go back to the Load menu on the menu 
bar, and select Options again.

The Options window appears.
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Note the following:

• Step 9, closing the Router Configurator following the router restart, is required 
to prevent the software attempting to restore the old configuration back into the 
router when the Extra Page is closed. 

• Although the router is in fact loaded, the Browser will not show it as loaded 
when you next start the Router Configurator. Once the router becomes reachable 
through its in-band management IP addres, you can  load it in the normal way.

Step Action Result

8. Remove all the information entered in step 
3, and click OK.

The next time you load, the Configu-
rator  will revert to using the in-band 
management address for loading. 

9. Without closing the Extra window, exit from 
the Router configurator. Either press ALT-4, 
or select Close on the Router menu. 
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Copying a Configuration

This appendix describes how to copy a router configuration. You can  copy a router 

configuration:

• From one router to another. You would  do this if you wanted the second router 
to have a very similar configuration to the first.

• To a different PC host. 

A.1 Copying a Router Configuration to Another Router

This section describes how to copy a configuration from one router to another router. 
Note that once you have copied a configuration, you must modify the addresses in 
the copied configuration, so that you do not have duplicate configuration on the net-
work.

A.1.1 Procedure

To copy a configuration , follow these steps:

1. In the Browser window, select the configuration you wish to copy. 

For example, you may wish to copy the configuration named RAEW associ-
ated with the router named Raew_NY.

2. Select Copy from the Router menu, or click the right mouse button and select 
Copy from the pop-up menu. 

3. In the Copy Router Configuration dialog, enter the name of the router to which 
the new configuration will apply, for example, Raew_MD.

4. By default, the new configuration name will be Config for Raew_MD. Change 
this name if you wish.

The new configuration will be an exact copy of the original configuration.

5. Now open the configuration for Raew_MD, and amend the configuration as 
described in Section A.1.2. 
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A.1.2 Avoiding Duplicate Addresses

Copying a configuration in this way means that you have created two configurations 
that are identical except for their different router and configuration names. This 
method will not remove any of the addresses defined in the configuration of the 
router.  It is essential that the two routers have different interface and management 
addresses.

In order to avoid duplicating network addresses on different routers, you should 
immediately change the addresses in the new configuration. 

A.1.3 Using a Configuration Template

You may wish to use the Copy feature to configure many routers from a standard 
configuration template. The general procedure is as follows:

1. Create a template configuration. 

Only include information that is applicable to all the router systems that will 
use it.  Omit addressing information - for example, the hardware address, IP 
addresses,  DECnet addresses, OSPF area information. 

2. Use the copy procedure described in Section A.1 to copy this configuration to 
each of the routers.

3. Open each of the new configurations. Add the missing information, and make 
any other changes required.

A.2 Copying to a Different PC Host 

This section describes how to copy a configuration to a different PC host.

A.2.1 Before You Begin

Make sure that the Router Configurator is running both on the host system you want 
to copy from and the system you want to copy to.

A.2.2 Procedure

Follow these steps:

1.  Copy a configuration, as described in Section A.1.

2. Find the name of the Data File for the configuration you have just copied.  This 
name will be shown in the Copy a configuration window. 
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The file name is also in the Browser window. If you cannot see the Data File 
Name column, go to the Browser menu on the menu bar and select:

Show Ð Data File Name 

3. Copy the Data File to the second PC host, using, for example, File Manager or 
Windows Explorer.

4.  On the second  host,  start the Router Configurator.

5. Go to the Router menu, and select New.

6. In the New Router window, enter a Router Name and Configuration name.

7. Type the name of the copied file into the Data File Name field (or use Browse to 
find it). When you have done this, you will see that the Hardware Type box is 
greyed out.

8. Set the Software Version and type as desired.

9. Click OK.

The new configuration will be an exact copy of the original configuration.

A.2.2.1 Procedure Using Microsoft Mail

If you have a Microsoft mail system installed, you can substitute the following pro-
cedure for steps 1 and 2 above. 

1. In the Router Configurator Browser, select the configuration you want to copy.

2. On the Router menu, select Send.

3. Select the destination/recipient, and send to the second PC. This sends the router 
data file.

4. When the file is received, place it in a file on the second PC.
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